Hospital and Health System
SAP Reporting Guide

Table of Contents

Report Selection Criteria: Key Terms ............................................................... 2
Display a Cost Center Group (KSH3) ............................................................... 3
Display a Cost Element Group (KAH3) .......................................................... 5

SAP Cost Object Reporting............................................................................... 7
Profit Center: Plan Actual Comparison Curr./Cumm. (Budget Variance ZFR1J) ..9
Cost Centers: One Line Summary Mo/YTD (ZFR1Q) ..................................... 14
Cost Centers: Current / Cumulative Comparison (ZFR1F) ............................ 19
Cost Centers: Actual/Plan/Commitments (ZFR1R) ........................................ 25
DUHS Multi Year Report by Project w/ Stat Posting (ZFR1N) ....................... 30

SAP Line Item Reporting ................................................................................. 35
Cost Centers: Display Actual Line Items (KSB1) ........................................... 36
Material Issues (Cost Centers: Display Actual Line Items KSB1) ....................... 39
Cost Centers: Commitment line items (KSB2) .............................................. 42

SAP Trend Reports .......................................................................................... 46
Cost Centers: Actual Trend by Cost Center w/ Stat (ZFR1V) ......................... 47

SAP Organizational Reports ............................................................................. 51
Accounting View of Payroll Activity (ZH223) ................................................... 52
Payroll Activity Detail Report – Multi-Period (ZH333) ....................................... 58

Printing a Report ............................................................................................. 62
Exporting a Report to Excel .......................................................................... 64
Report Selection Criteria: Key Terms

Cost Centers and Profit Centers:
- Created at each level within Duke where accountability of costs is required, usually at the department level.
- Identifies department “owners” of expenses and revenues, respectively.
- Nine digit numbers for DUHS companies (seven digits for University)
- Replaces term “fund code” at Duke.

Cost Center Groups:
- Groups one or more cost centers into reporting areas (known as nodes) which form a report hierarchy (organization chart for reporting).
- Two or eight digit numbers for DUHS companies (highest level of each company = last two digits of company code, e.g., 30 for Duke Hospital).
- Used as selection criteria in reports to generate a report at a division level.

Profit Center Groups:
- Groups one or more profit centers into reporting areas (known as nodes) which form a report hierarchy (organization chart for reporting).
- Two or Eight digit numbers for DUHS companies (highest level of each company = last two digits of company code, e.g., 30 for Duke Hospital).
- Used as selection criteria in reports to generate a report at a division level.

G/L Accounts and Cost Elements:
- Both terms basically mean the same thing in SAP.
- Six digit number (Duke’s old 4 digit object code + 2 extra digits)
- Defines “what” an amount is that is posted on the ledger (asset, liability, expense, or revenue).
- G/L (general ledger) account: used in financial accounting and on some reports to define assets, liabilities, expenses, or revenue.
- Cost element: used on cost center and profit center reports to define expenses or revenue.

Cost Element Group:
- Groups cost elements with similar characteristics together (examples include payroll costs, supplies and materials, etc.).
- Composed of primary cost elements, secondary cost elements, and even other groups of cost elements.
- Used as report selection to include multiple cost elements and provide subtotaling for certain groupings of cost elements.
Display a Cost Center Group (KSH3)

Via the User Menu: Financials → Financial Master Data → Cost Center Group (Transaction Code KSH3)

On the **Display Cost Center Group: Initial Screen:**

1. **Delete the value of DUKE_CCA in the Cost Center Group field.**
   
   *Note: If you leave DUKE_CCA, then the hierarchy will include all Cost Center Groups with Cost Centers for all the Company Codes of Duke (and may take a few minutes to run).*

2. **Enter the last two digits of the Company Code (e.g., 20, 30, or 50) in the Cost Center Group field to view all the groups for a company code.**
   
   *Note: Another option is to enter the eight digit Cost Center Group to view only Cost Centers associated with a division or lower level within a company code.*

3. **Click on the Hierarchy button (F6 or Enter button) to display the Display Cost Center Group: Structure screen (see below).**

4. **Click on the + folder icons to the left of higher level cost center groups until individual cost centers (nine digits) are displayed.**
To drill down and view more details about a single cost center:

5. **Double-click** on a **nine-digit cost center** to display the *Display Cost Center: Basic Screen.*

6. Review the general data about the Cost Center on the **Basic data** tab:
   - **Description** = longer name of the Cost Center (department or area).
   - **Person Responsible** of the cost center.
   - **Cost Center Category** = a one digit code that indicates the category for the cost center (use the drop-down to view the various categories).
   - **Hierarchy area** = the Cost center group (8 digits for DUHS) which is where the cost center rolls up in the report hierarchy.

   *Note:* While the Basic Data tab is the most useful tab, click on the other tabs for more details as needed. For instance, the Lock section under the Control tab displays if the Cost Center is blocked from postings of expenses (revenue is blocked). If all the boxes are checked, then the Cost Center cannot be used for posting of expenses.

7. When ready, click on the **Back** button (**F3**) to exit the Cost Center and return to the *Display Cost Center Group: Structure* screen.

**To exit the transaction:**

8. Click on the **Exit** button (**Shift+F3**) until the initial SAP screen is displayed.
Display a Cost Element Group (KAH3)

Via the User Menu: Financials → Financial Master Data → Cost Element Group (Transaction Code KAH3)

Note: If prompted, enter DUKE in the Controlling area field and click on the Enter button to display the Display Cost element group: Initial Screen.

On the Display Cost element group: Initial Screen:

1. Enter HSRPT in the Cost element group field.
   
   Note: HSRPT is the standard Cost Element Group for all the Health System company codes. The value can be found in a list via the field drop-down list if needed.

2. Click on the Hierarchy button (F6 or Enter button) to display the Display Cost element group: Structure screen (shown below).

3. Click on the + folder icons to the left of Cost Element Groups (like HS02_1) until the individual cost elements (six-digits) are displayed.
To drill down and view information about a single cost element:

4. **Double click** on a six-digit cost element to display the *Display Cost Element: Basic screen* (shown below).

5. Review the general data about the Cost Element on the **Basic data** tab:
   - **Description** = longer name of the Cost Element.
   - **CElem category** = a one digit code that indicates the category for the cost element (use the drop-down to view the various categories).

   *Note:* While the Basic Data tab is the most useful tab, click on the other tabs for more details as needed.

6. When ready, click on the **Back** button (**F3**) to return to the *Display Cost element group: Structure* screen.

**To exit the transaction:**

7. Click on the **Exit** button (**Shift+F3**) until the initial SAP screen is displayed.
SAP Cost Object Reporting

Profit Center: Plan Actual Comparison Curr./Cumm. (also known as the Budget Variance Report)

- Includes actual revenues and expenses by profit center and G/L account.
- Compares plan (budget) to actual amounts for the current period and YTD (cumulative through current period).
- Is not an ideal report to use for drilling into and analyzing the details for expenses. Use cost center reports for that function.
- Used for the preparation of the Budget Variance Report when exported to Excel, as may be required by Hospital and Health System Finance areas.

Cost Centers: One Line Summary Mo / YTD

- Includes actual EXPENSES only for the Health System.
- Compares plan (budget) to actual expenses for the current period and YTD (cumulative through current period).
- Provides a one line summary of expenses for each cost center chosen.
- Can use for drilling into and analyzing more details for expenses for each cost center and at the transaction level.

Cost Centers: Current / Cumulative Comparison

- Includes actual EXPENSES only for the Health System.
- Compares plan (budget) to actual expenses for the current period and YTD (cumulative through current period).
- Provides a detailed view of expenses by cost element and cost element groups for each cost center chosen.
- Is equivalent to the drill-down report from the Cost Centers: One Line Summary Mo/YTD report.
- Can use for drilling into and analyzing more details for expenses for each cost center and at the transaction level.

Cost Centers: Actual/Plan/Commitment

- Includes ACTUAL EXPENSES and COMMITMENTS (i.e. encumbrances or expenses that are in progress but not yet incurred).
- Compares the total of actual expenses and commitments to the plan (budget), and provides the available balance of funds.
- Can be generated either for the current period OR a cumulative view through the period selected in the from and to Period fields.
SAP Cost Object Reporting (cont.)

DUHS Multi Year Report by Project w/ Stat Posting

- Provides financial data for Capital Projects, such as construction projects, renovations, or equipment.
- Also provides financial data for temporary restricted net assets (the WBS Elements beginning with 30903xxxx, 50903xxxx, etc.) and permanently restricted net assets (the WBS elements beginning with 30904xxxx, 50904xxxx, etc.)
- Compares the total of actual expenses to the plan (budget), and provides the available balance of funds across the life of the project (multi year).
- Provides drilldown capability to further analyze amounts on the report.
On the **Plan Actual Comparison Curr./Cummm.: Selection** screen:

1. Enter **DUKE** in the **Controlling area** field (if not defaulted).
2. Enter the desired **fiscal year** in the **Fiscal Year** field.
3. Enter the **LAST CLOSED FISCAL PERIOD** in the **Current period** field (especially if using plan version = 0, flex budget).
4. Enter either a **0** (Flex or revised) or **1** (Original or fixed) in the **Plan version** field.
5. In the **Profit center** fields (Group or Single Values), choose one of the following options depending on your needs:
   - Enter a **Profit center group (8 digits)** in the **Profit Center (Group)** field (first field listed).
   - Enter a **single Profit center (9 digits)** in the **Single Values** field (second field listed – can also enter a range or use the **Multiple Selection** button to enter more than one Profit center if needed).
6. Enter **HSRPT** in the **Account (group, i.e. cost element group)** field.

**Note:** A single six digit G/L account (e.g., 646500) or multiple six digit accounts may also be entered in the **Or Values** field if desired.
7. Click on the Execute button (F8) to display the Plan Actual Comparison Curr./Cumm. Result screen (shown below).

8. In the Selection of set dialog box, double click on the second group listed - HSRPT with a Set class of Account Group.

On the Profit Ctr Plan Act Comp Curr/Cumm screen:

Note: If more than one Profit Center was selected for this report, then the subtotals and totals are consolidated for all Profit Centers selected. To see each individual Profit Center with individual totals, refer to steps on next page. This report is not ideal for drilling down to line items and document details. Use cost center reports for the drill down.

9. Review the columns as outlined below:
   - The first three columns compare Plan (budget) to actual revenue and expense for the fiscal period selected.
   - The second three columns compare Year-to-Date Plan (budget) to actual revenue and expense through the fiscal period selected.
10. To vertically scroll through this report, use the following buttons:
   - **First Page (Ctrl+Page up)** to scroll to the top cover page.
   - **Next Page (Page down)** to scroll to the next page.
   - **Previous Page (Page up)** to scroll to the previous page.
   - **Last Page (Ctrl+Page down)** to scroll to the last page.

**To see which Profit Centers are included on this summary report and navigate to a variation of the report for just one Profit Center:**

   
   **Note:** This function is only available and useful on consolidated reports where more than one Profit Center is included on the report.

   
   11. Click on the **Navigation** button to display the Variation: Profit Center screen (if not already displayed – see note below).

   **Note:** This button toggles between turning the navigation window “on” and “off” on the left side of the screen.

   12. Click on the **button** to **expand the groups** if applicable.

   13. **Locate the desired Profit Center** by navigating through the graphical hierarchy (open folders if needed).

   14. **Double-click on the line** for the desired Profit Center.

   15. To scroll through other Profit Centers (same level), use the following:

   - **Left** button or press Ctrl+Shift+F2
   - **Right** button or press Ctrl+Shift+F3

   16. To move up or down the hierarchical levels, use the following:

   - **Previous level** button (Ctrl+Shift+F1)
   - **Next level** button or press Ctrl+Shift+F4
Variation: To return to the original report setting (consolidated):

17. **Double click** anywhere on the * or **text of the top line** (with the first folder – not the Current setting line) of the display tree.

   *Note:* Another option is to click on the *Previous level* button until the original level is reached.

To collapse or expand line items above subtotal and total lines:

18. To collapse or hide detailed lines above a subtotal (highlighted in color), click on the **Collapse** button to the left of a subtotal.

19. To expand or show the lines again, click on the **Expand** button to the left of a subtotal that is collapsed.

   *Note:* To collapse or expand all items above all subtotal lines, follow menu path **View → Expand report fully** or **View → Collapse report fully**.

```
<table>
<thead>
<tr>
<th>Current period</th>
<th>11</th>
<th>11</th>
<th>11</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current period definition</td>
<td>May 2004</td>
<td>May 2004</td>
<td>May 2004</td>
</tr>
<tr>
<td>Revenue and cost elements</td>
<td>11 MAY Plan postings</td>
<td>11 MAY Actual posting</td>
<td>Var(abs)</td>
</tr>
<tr>
<td>* 35109. INPATIENT REVENUE</td>
<td>5,951,863.40</td>
<td>7,211,912.02</td>
<td>1,260,048.62</td>
</tr>
<tr>
<td>* 35509. OUTPATIENT REVENUE</td>
<td>16,996,753.79</td>
<td>12,645,372.18</td>
<td>1,085,981.60</td>
</tr>
<tr>
<td>** TOTAL GROSS PATIENT REVENUE</td>
<td>18,998,617.19</td>
<td>19,857,284.28</td>
<td>2,925,067.08</td>
</tr>
</tbody>
</table>
```

```
OPTIONAL STEPS

20. **OPTIONAL:** Print the report if desired (see the *Printing a Report* section of manual).

21. **OPTIONAL:** If a Clinical Business Unit (Duke Hospital), export the report to Excel to prepare the Budget Variance report (see the *Exporting a Report* section of manual – System → List → Save → Local File).

   Note: This report has a blank header page that may export to Excel. Therefore, blank lines will appear at the top of the Excel spreadsheet. Scroll or page down until the exported data is displayed and delete the blank lines from the Excel spreadsheet if desired.

**To exit the report when ready:**

22. Click on the **Back** button (F3) to display the *Query: Save extract* dialog box.

23. Click the **NO** button (do not save an extract) to display the Z001 Plan Actual Comparison Curr./Cumm.: Select screen.

24. Click on the **Exit** button (Shift+F3) until the initial SAP screen is displayed.
Cost Centers: One Line Summary Mo/YTD (ZFR1Q)

Via User Menu: Financials → DUHS Reporting Cost Object Reporting → Cost Centers: One Line Summ Mo/YTD w Stat Rev. (Transaction Code ZFR1Q)

On the One Line Summ Mo/YTD with Stat Rev: Selection screen:

1. Enter DUKE in the Controlling area field.
2. Enter the desired Fiscal year.
3. Enter the fiscal period(s) in the From period and To period fields.
   Note: If plan version 0 (Flex budget) is used per next step, enter Period 1 to the last closed fiscal period for YTD plan to actual data. Flex budgets are loaded at fiscal month end, so it will be unavailable in a current open fiscal month. If only one period is desired, use the same period in the From and To fields.
4. Enter either a 0 (Flex or revised) or 1 (Original or fixed) in the Plan version field.
5. In the Cost center fields (Cost Center Group / OR Values), choose one of the following options depending on your needs:
   - Enter a Cost center group (8 digits) in the Cost center group field.
   - Enter a single Cost center (9 digits) in the Or Values field (enter a range or use the Multiple Selection button to enter more than one Cost center if needed).
6. Enter HSRPT in the Cost element group field.

   Note: A single six digit cost element, (i.e. G/L account, e.g., 646500), range of cost elements, or multiple cost elements may also be entered in the last Or value(s) field if desired.

7. Click the Execute button to execute the report and display the One Line Summ Mo/YTD screen (shown below).

On the Cost centers: One Line Summ Mo/YTD: Result screen:

8. Use the horizontal scroll bar to review the columns as outlined below:
   - The first three columns compare Plan (budget) to actual expense for the fiscal period selected.
   - The second three columns compare Year-to-Date Plan (budget) to actual expense through the fiscal period selected.

9. To vertically scroll through this report, use the following buttons:
   - First Page (Ctrl+Page up) to scroll to the top cover page.
   - Next Page (Page down) to scroll to the next page.
   - Previous Page (Page up) to scroll to the previous page.
   - Last Page (Ctrl+Page down) to scroll to the last page.
10. Double-click on the appropriate amount for the cost center line and the column as outlined below:

- The amount in the **Cur Mo. Var** (Current Month variance) column to see just the current period (3 in the example above).
- OR the amount in the **YTD Var.** (YTD variance) column to see the all the periods (1-3 in the example above).

11. In the Select Report dialog box (shown above), double click on the Cost centers: Actual/plan/variance option.

12. On the Cost Centers: Actual/Plan/Variance report screen (above), review the columns of data for the individual cost center at the cost element level.

- The columns compare actual expense to the Plan (budget) for the fiscal period selected. A positive amount in the Var. (abs.) column indicates that actual amounts are OVER the Plan (budget).
From the cost element level report, to drill down and view the actual line item details:

13. Choose one of the options depending on your needs:
   
   - To view the line items for one cost element, **double click** on the dollar amount in the Act. Costs (Actual costs) column for that cost element.
   
   - To view the line items for a cost element group, **double click** on the dollar amount for the cost element group like Total Non-Medical Supplies (shaded in light yellow) in the Act. Costs (Actual costs) column.
   
   - To view the line items for all cost elements, **scroll to the bottom of the report** and **double click** on the very last total amount (shaded in dark yellow) in the Act. Costs (Actual costs) column.

15. On the Display Actual Cost Line Items for Cost Centers report screen (shown above), review the columns of data as needed. 

*Note:* The columns and navigational tips for this line item report are outlined in the Guide under the Cost Center: Actual Line Item report. Depending on the Layout defaulted (see header of report), the columns and subtotals of the report may vary.

To drill down to the document level for a line item amount:

16. Double click anywhere on a specific line item to display one of various document screens.

*Note:* Once in a document, use the appropriate buttons to display other information.

To return to the original view of the report (one line summary):

17. Click the **Back** button to return to the Display Actual Cost Line Items for Cost Centers screen.

18. Click the **Back** button again and click the **Yes** button to **exit the list** and return to the Cost centers: actual/plan/variance: Result screen.

19. Click the **Back** button again and click the **Yes** button to **exit the report** and return to the One Line Summary Mo/YTD: Result screen.

To exit the report when ready:

20. Click on the **Exit** button (**Shift+F3**) until the initial SAP screen is displayed.
Cost Centers: Current / Cumulative Comparison (ZFR1F)

Via User Menu: Financials → DUHS Reporting → Cost Object Reporting → Cost Centers: Current/Cumulative Com (Transaction Code ZFR1F)

On the Cost Centers: Current/Cumm. With Stat Rev.: Selection screen:

1. Enter DUKE in the Controlling Area field.
2. Enter the desired fiscal year in the Fiscal Year field.
3. Enter the fiscal period in the Period field.
   
   Note: If plan version 0 (Flex budget) is used per next step, enter Period 1 to the last closed fiscal period for YTD plan to actual data. Flex budgets are loaded at fiscal month end, so it will be unavailable in a current open fiscal month. If only one period is desired, use the same period in the From and To fields.

4. Enter either a 0 (Flex or revised) or 1 (Original or fixed) in the Plan version field.
5. In the Cost center fields (Cost Center Group / OR Values), choose one of the following options depending on your needs:
   
   • Enter a Cost center group (8 digits) in the Cost center group field.
   • Enter a single Cost center (9 digits) in the Or Values field (may enter a range or use the Multiple Selection button to enter more than one Cost center if needed).
6. Enter **HSRPT** in the **Cost element group** field.

   **Note:** A **single six digit cost element**, (i.e. G/L account, e.g., 646500), range of cost elements, or multiple cost elements may also be entered in the last **Or value(s)** field if desired.

7. Click the **Execute** button to execute the report and display the Cost centers: Actual/plan/commit. screen (see below).

### On the **CCtrs: Current/Cumm.** screen:

8. Use the **horizontal scroll bar** to review the columns as outlined below:

   - The **first three columns** compare **Plan (budget) to actual expense for the fiscal period selected**.
   - The middle column provides the six digit Cost Element (i.e., G/L Account) and description in blue or the Cost Element Group sub-total in yellow.
   - The **second three columns** compare **Year-to-Date Plan (budget) to actual expense through the fiscal period selected**.

   **Note:** This report provides summary detail by each cost element for the cost center(s) selected. If multiple cost centers were selected, the initial view of the report is consolidated, including all cost centers together in the totals. See outline of columns below and the navigation section on the next page.
9. To vertically scroll through the pages of the report and view all lines, subtotals and totals, use the following buttons:
- **First Page (Ctrl+Page up)** to scroll to the top cover page.
- **Next Page (Page down)** to scroll to the next page.
- **Previous Page (Page up)** to scroll to the previous page.
- **Last Page (Ctrl+Page down)** to scroll to the last page.

**On the CCtrs: Current/Cumm. report, to see which Cost Centers are included and navigate to a variation for just one Cost Center:**

*Note: This function is only available and useful on consolidated reports where more than one Cost Center is included on the report.*

10. Click on the **Navigation** button to display the Variation: Cost Center screen (if not already displayed – see note below).

*Note: This button toggles between turning the navigation window “on” or “off” (on left side).*

11. Click on the **button to expand the groups** if applicable.

12. **Locate the desired Cost Center** by navigating through the graphical hierarchy (open **folders** if needed).

13. **Double-click on the line** for the desired Cost Center.
14. To scroll through other Cost Centers (same level), use the following:

- **Left** button or press **Ctrl+Shift+F2**
- **Right** button or press **Ctrl+Shift+F3**

15. To move up or down the hierarchical levels, use the following:

- **Previous level** button (Ctrl+Shift+F1)
- **Next level** button or press **Ctrl+Shift+F4**

16. To return to the original consolidated report, double click anywhere on the * or text of the top line (with the first folder – not the Current setting line) of the display tree.

   **Note:** Never use the **Back** button to return to a previous screen. Another option is to click on the **Previous level** button until the original level is reached.

**On the CCtrs: Current/Cumm. report, to collapse (hide) or expand (show) line items above subtotal and total lines:**

17. Click on the **Collapse** button to the left of a subtotal (highlighted in yellow or green) to collapse or hide the lines above that subtotal for a more summarized view of the report.

18. Click on the **Expand** button to the left of a subtotal that is collapsed, to expand or show the lines again for a more detailed view of the report.

   **Note:** In some reports, the **Expand all** and **Collapse all** buttons are also available on the tool bar. These buttons expand or collapse all items above all subtotal lines. If not available, try the menu path View → Hierarchy → Expand all or View → Hierarchy → Collapse all.
19. Choose *one of the options* depending on your needs:

- To view the line items for **one cost element**, double click on the dollar amount in the *Curr. Mo. Actual OR YTD Actual* column for that cost element (e.g. 646500 Patient Care Supplies or 645000 Lab Supplies).

- To view the line items for a **cost element group**, double click on the dollar amount in the *Curr. Mo. Actual OR YTD Actual* column for the **cost element group** shaded in light yellow (e.g., Patient Care Supplies or Total Medical Supplies).

- To view the line items for all **cost elements** (equivalent to running a line item report by month or YTD), scroll to the bottom of the report and double click on the **very last total amount** in the *Curr. Mo. Actual OR YTD Actual* column (shaded in dark yellow).
20. At the Select Report dialog box, double click on either Cost Centers: Actual Line Items.

21. On the Display Actual Cost Line Items for Cost Centers report, double click anywhere on a line item to further drill down to the document level.

22. Click the Back button or press F3 to return to the Display Actual Line Items for Cost Centers screen from the document level.

23. Click the Back button again or press F3 to exit this screen.

24. In the dialog box, click the Yes button to exit the list and return to the CCtrs: Current/Cumm. report.

To exit the report when ready:

25. Click on the Exit button (Shift+F3) until the initial SAP screen is displayed.
Cost Centers: Actual/Plan/Commitments (ZFR1R)

Via User Menu: Financials → DUHS Reporting → Cost Object Reporting → Cost Centers: Act./Plan/Commitments (Transaction Code ZFR1R)

On the Cost Centers Act./Plan/Commitments: Selection screen:

1. Enter DUKE in the Controlling area field.
2. Enter the desired Fiscal year.
3. Enter the fiscal period(s) in the From period and To period fields.
   Note: If plan version 0 (Flex budget) is used per next step, enter Period 1 to the last closed fiscal period for YTD plan to actual data. Flex budgets are loaded at fiscal month end, so it will be unavailable in a current open fiscal month. If only one period is desired, use the same period in the From and To fields.
4. Enter either a 0 (Flex or revised) or 1 (Original or fixed) in the Plan version field.
5. In the Cost center fields (Cost Center Group / OR Values), choose one of the following options depending on your needs:
   • Enter a Cost center group (8 digits) in the Cost center group field.
   • Enter a single Cost center (9 digits) in the Or value(s) field (may enter a range or use the Multiple Selection button to enter more than one Cost center if needed).
6. Enter HSRPT in the **Cost element group** field.

   *Note:* A single six digit cost element, (i.e. G/L account, e.g., 646500) or multiple cost elements may also be entered if desired.

7. Click the **Execute** button to execute the report and display the Cost centers: Actual/plan/commit. screen (see below).

**On the Cost centers: Actual/plan/commit. screen:**

![Cost centers: Actual/plan/commit. screen](image)

   **Note:** This report provides summary detail by each cost element for the cost center(s) selected and includes commitments along with actuals. See outline of columns below.

8. To horizontally scroll across the report and view more columns as outlined below, use the **horizontal scroll bar** at the bottom of the screen.

<table>
<thead>
<tr>
<th>Cost elements</th>
<th>The 6 digit cost element and description (identifies what type of amount is posted).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual</td>
<td>The actual amount of expenses already incurred by cost element for the period selected.</td>
</tr>
<tr>
<td>Commitment</td>
<td>The amount of commitments (purchase requisitions or orders in progress but not yet invoiced) posted for the cost element. The commitments displayed are based on the delivery date on the purchase order and the fiscal period end date selected.</td>
</tr>
<tr>
<td>Assigned</td>
<td>The <strong>Assigned</strong> column is the <strong>total</strong> of the <strong>Actual</strong> and <strong>Commitment</strong> column.</td>
</tr>
<tr>
<td>Plan</td>
<td>The original or flex plan (budget) that is loaded monthly from the budget system.</td>
</tr>
<tr>
<td>Available</td>
<td>The <strong>Available</strong> column is the <strong>Plan column less the Assigned</strong> column. A credit (-) in the Assigned column indicates that expenses will exceed the Plan (budget amount) for that cost element.</td>
</tr>
</tbody>
</table>
9. To vertically scroll through the pages of the report and view all lines, subtotals and totals, use the following buttons:

   - **First Page (Ctrl+Page up)** to scroll to the top cover page.
   - **Next Page (Page down)** to scroll to the next page.
   - **Previous Page (Page up)** to scroll to the previous page.
   - **Last Page (Ctrl+Page down)** to scroll to the last page.

10. **On the Cost centers: Actual/plan/commit** Report, to see which Cost Centers are included and navigate to a *variation* for just one Cost Center:

    **Note:** This function is only available and useful on consolidated reports where more than one Cost Center is included on the report.

11. Click on the **Navigation** button to display the Variation: Cost Center screen (if not already displayed – see note below).

    **Note:** This button toggles between turning the navigation window “on” or “off” (on left side).

12. **Locate the desired Cost Center** by navigating through the graphical hierarchy (open folders if needed).

13. **Double-click on the line** for the desired Cost Center.

14. To scroll through other Cost Centers (same level), use the following:

    - **Left** button or press **Ctrl+Shift+F2**
    - **Right** button or press **Ctrl+Shift+F3**

15. To move up or down the hierarchical levels, use the following:

    - **Previous level** button (Ctrl+Shift+F1)
    - **Next level** button or press **Ctrl+Shift+F4**
Cost Centers: Act./Plan/Commitment (cont.)

16. To return to the original consolidated report, double click anywhere on the * or text of the top line (with the first folder – not the Current setting line) of the display tree.

   Note: Never use the Back button to return to a previous screen. Another option is to click on the Previous level button until the original level is reached.

On the Cost Center: Actual/Plan/Commit. Report, to collapse (hide) or expand (show) line items above subtotal and total lines:

17. Click on the Collapse button to the left of a subtotal (highlighted in yellow or green) to collapse or hide the lines above that subtotal for a more summarized view of the report.

18. Click on the Expand button to the left of a subtotal that is collapsed, to expand or show the lines again for a more detailed view of the report.

   Note: In some reports, the Expand all and Collapse all buttons are also available on the tool bar. These buttons expand or collapse all items above all subtotal lines. If not available, try the menu path View → Hierarchy → Expand all or View → Hierarchy → Collapse all.

From the Cost Center: Actual/Plan/Commit. report (previous page), to drill down and view actual line item details:
19. Choose one of the options depending on your needs:

- To view the line items for one cost element, double click on the dollar amount in the Actual OR Commitment column for that cost element.

- To view the line items for a cost element group, double click on the dollar amount in the Actual OR Commitment column for the cost element group like Total Non-Medical Supplies (shaded in light yellow).

- To view the line items for all cost elements, scroll to the bottom of the report and double click on the very last total amount in the Actual OR Commitment column (shaded in dark yellow).

20. At the Select Report dialog box, double click on either Cost Centers: Actual line items OR Cost Centers: Commitment line items (below).

21. Double click anywhere on a line item to further drill down to the document level.

22. Click the Back button or press F3 to return to the Display Actual OR Commitment Line Items for Cost Centers screen.

23. Click the Back button again or press F3 to exit this screen.

24. In the dialog box, click the Yes button to exit the list and return to the Cost centers: Actual/plan/commit.: Result screen.

To exit the report when ready:

25. Click on the Exit button (Shift+F3) until the initial SAP screen is displayed.
DUHS Multi Year Report by Project w/ Stat Posting (ZFR1N)

Via User Menu: Financials → DUHS Reporting → Cost Object Reporting → DUHS Multi Year rep by Project w/ Stat po (Transaction Code ZFR1N)

On the **DUHS Multiyear Report w/ Stat Post: Selection** screen:

1. Enter a **single nine digit number** for the Capital Project (for construction / renovation or equipment) in the **Project** field(s) - (may enter a range or use the **Multiple Selection** button to enter more than one Project if needed).

2. Enter a **1** (Original or fixed) in the **Plan version** field.

3. Enter the desired **Fiscal year**.

4. Enter **HSRPT** in the **Cost element group** field.

   **Note:** A single six digit cost element, (i.e. G/L account, e.g., 646500) or multiple cost elements may also be entered if desired.

5. Click the **Execute** button to execute the report and display the **Cost centers: Actual/plan/commit.** screen (see below).
On the **DUHS Multi Year Rpt.** screen:

![Screen Capture of DUHS Multi Year Report](image)

**Note:** This report provides summary detail by each project selected and includes commitments along with actual amounts. This report contains “horizontal pages” which contain more data about the project as well. The example above is based on the selection of two projects (one for construction and one for equipment). See outline of columns below.

6. To scroll across the report to view all columns on the first “horizontal page” as outlined below, use the **horizontal scroll bar** at the bottom of the screen.

<table>
<thead>
<tr>
<th>Cost objects</th>
<th>The nine digit project number (WBS Element) associated with the construction/renovation project or the equipment. Note that projects may have multi-levels as indicated by the twelve digit number (contains a –XX extension to show levels within a project).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actual Overall</td>
<td>The actual amount of expenses already incurred for the life of the project selected (overall).</td>
</tr>
<tr>
<td>Plan Overall</td>
<td>The original plan (budget) that is loaded monthly from the budget system for the entire project (overall).</td>
</tr>
<tr>
<td>Variance Overall</td>
<td>The <strong>Available</strong> column is the <strong>Plan column less the Assigned</strong> column. A <strong>credit</strong> (-) in the <strong>Assigned</strong> column indicates that expenses will exceed the Plan (budget amount) for that cost element.</td>
</tr>
<tr>
<td>Commitment</td>
<td>The amount of commitments posted for the project selected (purchase requisitions or purchase orders in progress but not yet invoiced, i.e., not included in the Overall Actual column yet). The commitments displayed are based on the delivery date on the purchase order and the fiscal period end date selected.</td>
</tr>
</tbody>
</table>
DUHS Multi Year Rep by Project (cont.)

7. To scroll to the other “horizontal pages” which contain more data like the current month financial data, and to return to the previous pages, use the following buttons:
   - **To the far left** to scroll to the horizontal page farthest to the left.
   - **Page left** to scroll to the next horizontal page to the left.
   - **Page right** to scroll to the next horizontal page to the right.
   - **To the far right** to scroll to the horizontal page farthest to the right.

   **Note:** If desired, use the **Page right** button a few times to view the current year’s columns of data, similar to the Overall columns outlined on the previous page.

8. To vertically scroll through the pages of the report, if applicable, and view all lines, subtotals and totals, use the following buttons:
   - **First Page (Ctrl+Page up)** to scroll to the top cover page.
   - **Next Page (Page down)** to scroll to the next page.
   - **Previous Page (Page up)** to scroll to the previous page.
   - **Last Page (Ctrl+Page down)** to scroll to the last page.

**On the Cost Center: Actual/Plan/Commit. Report, to collapse (hide) or expand (show) line items above subtotal and total lines:**

9. Click on the **Collapse** button to the left of a subtotal (highlighted in yellow or green) to collapse or hide the lines above that subtotal for a more summarized view of the report.

10. Click on the **Expand** button to the left of a subtotal that is collapsed, to expand or show the lines again for a more detailed view of the report.

   **Note:** In some reports, the **Expand all** and **Collapse all** buttons are also available on the tool bar. These buttons expand or collapse all items above all subtotal lines. If not available, try the menu path **View → Hierarchy → Expand all or View → Hierarchy → Collapse all.**
From the DUHS MultiYear Rpt, to drill down and view actual line item details:

11. Choose one of the options depending on your needs:

- To view the line items for one cost object (for this report = project or WBS Element for levels), double click on the dollar amount in the Actual Overall column for that cost object.

- To view the line items for a subtotal or total amount for levels of projects or more than one project, double click on the dollar amount in the Actual Overall column for the subtotal or total desired (shaded in light or dark yellow).

12. On the resulting Actual/Plan/Variance report (shown above), continue to double click on desired amounts in the Actual column for a cost element or a cost element group (shaded in yellow) to further drill down to the actual line items.
**Note:** Settlement rules apply to the capital projects. Operating expenses cannot be charged on a capital WBS Element (i.e., project or level of a project). If operating expenses are charged, a settlement journal entry will be done to clear all operating expenses from the project. Those settlement entries will show up in G/L accounts 668179 and 668180. The charges are moved to the project’s corresponding departmental operating cost center with an offsetting credit to the capital WBS Element (project).

13. Click the **Back** button or press **F3** as many times as needed to return to the previous drill-down screens.

14. When prompted by the dialog box, click the **Yes** button to exit the report and return to the **DUHS MultiYear Rpt** screen.

**To exit the report when ready:**

15. Click on the **Exit** button (**Shift+F3**) until the initial SAP screen is displayed.
SAP Line Item Reporting

Cost Centers: Display Actual Line Items
- Provides detailed line items for actual expenses only (no Plan/budget).

Cost Centers: Reporting for Material Issues (Display Actual Line Items)
- Is a variation of the Cost Centers: Actual Line Items report.
- Uses SAP material numbers as extra selection criteria on the initial screen.
- Provides detailed line items for purchases that reference an SAP material number (ZM10 reservations from Material Services and larger vendors like Allegiance).
- Replaces the Material Issues Report that was distributed in the past by Duke Hospital's Material Management area.

Cost Centers: Display Commitment Line Items
- Provides detailed line items for commitments only (i.e. encumbrances or expenses that are in progress but not yet incurred).
Cost Centers: Display Actual Line Items (KSB1)

Via User Menu: Financials → DUHS Reporting → Line Item Reporting → Cost Centers: Display Actual Line Items (Transaction Code KSB1)

On the Display Actual Cost Line Items for Cost Centers: Initial Screen:

1. In the Cost center or Cost center group fields, choose one of the following options depending on your needs:
   - Enter a single Cost center (9 digits) in the Cost Center field (enter a range or use the Multiple Selection button to enter more than one Cost center if needed).
   - Enter a Cost center group (8 digits) in the Cost center group field.

2. Enter HSRPT in the Cost element group field.
   Note: A single six digit cost element, (i.e. G/L account, e.g., 646500), range of cost elements, or multiple cost elements may also be entered in the Cost Element field if desired.

3. Enter the beginning and ending date for the desired period in the FIRST Posting date and the SECOND Posting date fields.
   Note: The default posting dates represent the current open accounting period (i.e. fiscal month). The dates can be changed to choose a different fiscal month, a quarter, or YTD.

4. Enter /DUKE in the Layout field (or choose others via the Drop-down).
5. **Optional**: To increase number of lines displayed on a report from 5000 to a larger number:
   - Click on the **Further Settings** button
   - Enter **9999999** (seven 9s) in the field
   - Click on the **Continue** button.

6. Click on the **Execute** button or press **F8** to display the **Display Actual Cost Line Items for Cost Centers** screen (shown next page).

**On the Display Actual Cost Line Items for Cost Centers screen:**

Note: This report is based on the /DUKE layout and is sorted/subtotaled by the Period. Each line of this report represents one line item posted to the cost center(s) selected from an SAP document.

7. Click on the **horizontal scroll bar** to view columns outlined below (based on /DUKE layout):

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRw</td>
<td>The number of the corresponding line item on the source (or supporting) document as a reference in the drill down process.</td>
</tr>
<tr>
<td>DocDate</td>
<td>The document date that was keyed in the header when the document was created (e.g., invoice = invoice date).</td>
</tr>
<tr>
<td>Per</td>
<td>The fiscal period in which the document was posted.</td>
</tr>
<tr>
<td>F. Yr</td>
<td>The fiscal year in which the document was posted.</td>
</tr>
<tr>
<td>Cost Center</td>
<td>The seven digit number (fund code) for the Cost Center selected.</td>
</tr>
<tr>
<td>Cost Element</td>
<td>The six digit cost element (identifies what type of amount is posted, i.e., old 4 digit object code plus 2 digits).</td>
</tr>
<tr>
<td>Cost Element Name</td>
<td>The name or description of the cost element to which this line item of a document was posted.</td>
</tr>
</tbody>
</table>
Cost Centers: Actual Line Items (cont.)

<table>
<thead>
<tr>
<th>Val COCurr</th>
<th>The actual amount that was posted for one line item of a document to the Cost Center(s) selected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A text description specific to the line item posted from a document. For journal entries the text entered for the line item is displayed in this column.</td>
</tr>
<tr>
<td>RefDocNo</td>
<td>The SAP document number assigned by the system as the reference number.</td>
</tr>
<tr>
<td>DocTyp</td>
<td>A two digit identifier of the type of document from which the line item was posted (See Document Type List provided in class).</td>
</tr>
<tr>
<td>Document Header Text</td>
<td>The text entered on a document header. This text is a general description that pertains to the entire document versus just a line item of a document.</td>
</tr>
<tr>
<td>Reference</td>
<td>Contains other reference information for this line item, such as the Pre-assigned JV number for journal entries.</td>
</tr>
<tr>
<td>Offset. Acct Name</td>
<td>The offsetting account name can contain a vendor name if applicable. For other line items it may contain other useful information.</td>
</tr>
</tbody>
</table>

To drill down to the source or supporting document:

8. Double click on individual line items to display the source documents.

   Note: Once in a document, use the appropriate buttons to display other information. For further help, refer to the Reconciliation and Documents Guide.

9. Click the Back button or press F3 to return to the Display Actual Cost Line Items for Cost Centers screen.

To exit the report when ready:

10. Click the Exit button or press Shift+F3 until the initial SAP screen is displayed.

   Note: Unless otherwise preferred, click the Yes button when asked if you wish to exit the list.
Material Issues (Cost Centers: Display Actual Line Items KSB1)

Via User Menu: Financials → DUHS Reporting → Line Item Reporting → Cost Centers: Display Actual Line Items (Transaction Code KSB1)

Note: This report is a variation of the Cost Centers: Display Actual Line Items report (previous section).

1. Follow steps 1-6 of the Cost Centers: Display Actual Line Items section to access the screen and enter data in the fields (see below).

To enter additional selection criteria (to select only line items that contain an SAP material number):

2. Click on the Further selection criteria... button (shown above) to display the Define More Selection Criteria dialog box (shown below).

3. Click once on the triangle button beside Documents/Objects to open that folder.
Material Issues (cont.)

4. **Double click** on the **Material** field to select and display the input fields for Material number on the right side of the window.

5. Enter the range **1 to 9999999999 (eleven 9's)** in the Material range fields.

6. Click on the **Save** button or press **Ctrl+S** to return to the **Display Actual Cost Line Items for Cost Centers: Initial Screen**.

**Enter the criteria in the Settings section on the Display Actual Cost Line Items for Cost Centers: Initial Screen:**

7. Enter **/DUKE2** in the **Layout** field (use Drop-down to select).
   
   **Note:** The layout **/DUKE2** provides columns of data for material related expenses and subtotals by material number. Two other preferred options for less detail are the layouts **/DUKE5** and **5SAP**.

8. **Optional:** To increase number of lines displayed on the report from 5000 to a larger number, click on the **Further Settings** button, enter **9999999** (seven 9s) in the field and click on the **Continue** button.

9. Click on the **Execute** button to display the **Display Actual Cost Line Items for Cost Centers** screen.

**On the Display Actual Cost Line Items for Cost Centers screen:**

![Display Actual Cost Line Items for Cost Centers](image)

**Note:** This report is based on the **/DUKE2** layout and is sorted/subtotaled by the Material number. Each line of this report represents one line item posted to the cost center from an SAP document.
Material Issues (cont.)

10. Use the horizontal scroll bar to view columns as outlined below (per /DUKE2 Layout):

<table>
<thead>
<tr>
<th>Purchasing Doc.</th>
<th>The Purchase Order number if applicable.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Posting Date</td>
<td>The date the document was posted.</td>
</tr>
<tr>
<td>Posting Row</td>
<td>The corresponding row from the source document (aids in the drill-down process).</td>
</tr>
<tr>
<td>Name of Offsetting Account</td>
<td>The most line items, this column contains MM - MED SUPPLIES which indicates the materials were issued from Materials Management central areas. This column can contain a vendor name if applicable.</td>
</tr>
<tr>
<td>Cost Element</td>
<td>The six digit cost element (identifies what type of amount is posted, i.e., old 4 digit object code plus 2 digits).</td>
</tr>
<tr>
<td>Material</td>
<td>The SAP material number associated with the item that was issued and posted to the cost center.</td>
</tr>
<tr>
<td>Material Description</td>
<td>The description of the material that was issued and posted to the cost center.</td>
</tr>
<tr>
<td>Quantity</td>
<td>The quantity of the material that was issued and posted to the cost center.</td>
</tr>
<tr>
<td>PUM</td>
<td>The purchasing unit of measure for the material that was issued and posted to the cost center.</td>
</tr>
<tr>
<td>Val COCurr</td>
<td>The actual amount that was posted for material that was issued.</td>
</tr>
<tr>
<td>Cost Center</td>
<td>The 9 digit cost center that incurred the posting of expense for the SAP material that was issued.</td>
</tr>
</tbody>
</table>

To drill down and display the source document for the line item amount:

11. Double click on individual line items to display the documents.

   **Note:** Once in a document, use the appropriate buttons to display other information. For further help, refer to the Reconciliation and Documents Guide.

12. Click the **Back** button or press **F3** to return to the *Display Actual Cost Line Items for Cost Centers* screen.

To exit the report when ready:

13. Click the **Exit** button until the initial SAP screen is displayed.

   **Note:** Unless otherwise preferred, click the **Yes** button when asked if you wish to exit the list.
Cost Centers: Commitment line items (KSB2)

Via User Menu: Financials → DUHS Reporting → Line Item Reporting → Cost Centers: Display Commitment Line Items (Transaction Code KSB2)

On the Display Commitment Line Items for Cost Centers: Initial Screen:

1. In the Cost center or Cost center group fields, choose one of the following options depending on your needs:
   - Enter a single Cost center (9 digits) in the Cost Center field (enter a range or use the Multiple Selection button to enter more than one Cost center if needed).
   - Enter a Cost center group (8 digits) in the Cost center group field.

2. Enter HSRPT in the Cost element group field.

   Note: This cost element group may be found via the drop down arrow to the right of the field. A single six digit cost element, (i.e. G/L account, e.g., 646500) or multiple cost elements may also be entered in the Cost Element field if desired.
3. Enter the beginning and ending date for the desired period in the **FIRST Posting date** and the **SECOND Posting date** fields.

   *Note:* The default dates represent the current open accounting period (i.e. fiscal month). To see older commitments, use **07/01/1998** in the beginning date field. Commitments post in the fiscal period based on the delivery date entered on the Purchase Requisition for that item. Be sure to enter an appropriate ending date to view outstanding commitments.

4. Click in the **Open Items Only** check box to ensure that only outstanding encumbrances are shown on the report.

   *Note:* Select this box to view only outstanding commitments and avoid viewing extra line items containing 0.00 balances for commitments already invoiced or received.

5. Leave **/DUKE** (**standard default**) in the **Display variant** field (use the **Drop down** button to choose if desired).

   *Note:* A display variant determines what columns of data are included on a report and how the data is sorted/subtotaled. **/DUKE** is recommended and is the default display variant in the drill down from Duke reports. The Display variant can easily be changed once in the report if desired.

6. **Optional:** To increase the number of lines displayed from 5000 on the report to a larger number, click on the **Further Settings** button, enter **9999999** (**seven 9s**) in the field and click on the **Continue** button.

7. Click on the **Execute** button to display the **Display Commitment Line Items for Cost Centers** screen (shown next page).
### Cost Centers: Commitment Line Items (cont.)

On the **Display Commitment Line Items for Cost Centers** screen:

![Display Commitment Line Items for Cost Centers](image)

**Note:** This report is based on the /DUKE display variant and is sorted/subtotaled by the Period. Each line of this report represents one line item posted to the cost center(s) from a Purchase Order or Requisition.

8. Use the horizontal scroll bar to view columns as outlined below (per /DUKE Layout):

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Doc Category</td>
<td>The reference document category of the source (or supporting) document.</td>
</tr>
<tr>
<td>Per</td>
<td>The fiscal period in which the document was posted.</td>
</tr>
<tr>
<td>F. Yr</td>
<td>The fiscal year in which the document was posted.</td>
</tr>
<tr>
<td>Cost Ctr</td>
<td>The seven digit cost object number (fund code) for the Cost Center selected.</td>
</tr>
<tr>
<td>Debit Date</td>
<td>The date the Cost Center was charged.</td>
</tr>
<tr>
<td>Cost Element</td>
<td>The six digit cost element (identifies what type of amount is posted, i.e., old 4 digit object code plus 2 digits).</td>
</tr>
<tr>
<td>Cost Element Name</td>
<td>The name or description of the cost element to which this line item of a document was posted.</td>
</tr>
<tr>
<td>Val COCurr (commitments)</td>
<td>The actual commitment amount that was posted for one line item of a purchase order or purchase requisition to the cost center(s) selected. The commitments displayed are based on the delivery date on the purchase order and the fiscal period end date selected.</td>
</tr>
<tr>
<td>Name</td>
<td>A text description specific to the line item posted from a document.</td>
</tr>
<tr>
<td>RefDocNo</td>
<td>The SAP document number assigned by the system as the reference number. Only purchase orders or purchase requisitions are displayed on a commitment line item report.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Numerical identifier of the vendor involved in the purchase.</td>
</tr>
</tbody>
</table>
To drill down to the source or supporting document:

9. Double click on individual line items to display the documents.
   
   Note: Once in a document, use the appropriate buttons to display other information. For further help, refer to the Reconciliation and Documents Guide for more on Purchase Orders and Purchase Requisitions.

10. Click the Back button (F3) to return to the Display Actual Cost Line Items for Cost Centers screen.

To exit the report when ready:

11. Click the Exit button (Shift+F3) until the initial SAP screen is displayed.
   
   Note: Unless otherwise preferred, click the Yes button when asked if you wish to exit the list.
SAP Trend Reports

The SAP system provides numerous standard reports within different areas/modules of the system. The Trend Reporting folder contains several reports that compare expenses and/or revenue over a period of time. While only one example of a trend report is included in this Guide, each report name indicates the type of comparison in the report, and all the reports are similar in the selection criteria to the example included in this Guide. So any report in the Trend folder may be beneficial depending on your needs.

Cost Center: Actual Trend by Cost Center w/ Stat (ZFR1V)

- Is easily accessed via the transaction code ZFR1V as well as customized Duke customized report tree (ZFR1, Duke Favorites).
- Provides a comparison of actual expenses across a period of months that are selected with a Plan to total expense comparison included.
- Allows drill down to view details of actual expenses (cannot drill-down on Plan total in one of last columns).
On the **Actual Trend by Cost Centers w/ Stat: Selection** screen:

1. Enter **DUKE** in the Controlling area field.
2. Enter the desired **Fiscal year**.
3. Enter the **fiscal period(s)** in the **From period** and **To period** fields.
   
   *Note:* If plan version 0 (Flex budget) is used per next step, enter **Period 1 to the last closed fiscal period** for YTD plan to actual data. Flex budgets are loaded at fiscal month end, so it will be unavailable in a current open fiscal month. **If only one period is desired, use the same period in the From and To fields.**

4. Enter either a **0** (Flex or revised) or **1** (Original or fixed) in the **Plan version** field.

5. In the Cost center fields (Cost Center Group / OR Values), choose one of the following options depending on your needs:
   - Enter a **Cost center group (8 digits)** in the **Cost center group** field.
   - Enter a **single Cost center (9 digits)** in the **Or value(s)** field (may enter a range or use the **Multiple Selection** button to enter more than one Cost center if needed).
6. Enter **HSRPT** in the **Cost element group** field.

   *Note:* A single six digit cost element, (i.e. G/L account, e.g., 646500) or multiple cost elements may also be entered if desired.

7. Click the **Execute** button to execute the report and display the **Cost centers: Actual/plan/commit** screen (see below).

**On the Cost Ctr Area Trend screen:**

![Cost Ctr Area Trend screenshot]

**Note:** This report provides the actual expenses for each period for the cost centers selected. The report provides an easy way to compare several periods of expenses side by side in order to establish if there is a trend in the fluctuation of expenses. There are other trend reports that compare G/L accounts / Cost Elements if needed. See outline of columns below.

8. To horizontally scroll across the report pages to view all the columns selected per the outline below (only the first 5 periods will show on the initial page), use the **Page right** button at the top of the screen.

<table>
<thead>
<tr>
<th>Cost Center</th>
<th>Title says Cost elements, but this column contains the Cost Centers selected in a one-line summary type of display.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Per # Act</td>
<td>The actual amount of expenses incurred for the period selected and indicated by the Period number in the column heading.</td>
</tr>
<tr>
<td>Total Act</td>
<td>The total sum of expenses for all the periods selected for this report.</td>
</tr>
<tr>
<td>YTD Plan</td>
<td>The year-to-date budget or plan amount for the total of the periods selected.</td>
</tr>
<tr>
<td>B / (W)</td>
<td>Compares the Total Act column to the YTD Plan column. A negative indicates that the Total Actual is greater than the Plan/Budget for the timeframe selected. <strong>B / (W)</strong> % shows as a percentage.</td>
</tr>
</tbody>
</table>
9. To scroll back to previous pages with columns of period expenses, use either the Page left or To the far left buttons at the top.

10. To vertically scroll through the pages of the report and view all lines, subtotals and totals, use the following buttons:
- First Page (Ctrl+Page up) to scroll to the top cover page.
- Next Page (Page down) to scroll to the next page.
- Previous Page (Page up) to scroll to the previous page.
- Last Page (Ctrl+Page down) to scroll to the last page.

On the Cost Ctr Area Trend report, to collapse (hide) or expand (show) line items above the total line:

11. Click on the Collapse button to the left of a subtotal (highlighted in yellow or green) to collapse or hide the lines above that subtotal for a more summarized view of the report.

12. Click on the Expand button to the left of a subtotal that is collapsed, to expand or show the lines again for a more detailed view of the report.

Note: In some reports, the Expand all and Collapse all buttons are also available on the tool bar. These buttons expand or collapse all items above all subtotal lines. If not available, try the menu path View → Hierarchy → Expand all or View → Hierarchy → Collapse all.
Cost Centers: Actual Trend (cont.)

From the Cost Ctr Area Trend report (previous page), to drill down and view actual expense line item details:

13. Choose one of the drill-down options below based on your needs:
   - To view the actual expense line items for a period for one cost center listed, double click on the amount in that period column.
   - To view the actual expense line items for all periods displayed for one cost center, double click on the cost center number in the first column or the amount in the Total column for that cost center.
   - To view the total expenses for a period of cost center, double click on the appropriate amount on the Total Costs line.

14. Once in the Cost Center Actual Line Item report, double click anywhere on a line item to further drill down to the document level.

15. To exit a document, click the Back button or press F3 to return to the Display Actual Line Items for Cost Centers screen.

16. To exit the line item report, click the Back button again or press F3 to exit this screen.

17. In the dialog box, click the Yes button to exit the list and return to the Cost Ctr: Area Trend screen.

To exit the report when ready:

18. Click on the Exit button (Shift+F3) until the initial SAP screen is displayed.
SAP Organizational Reports

The SAP system provides numerous standard reports within different areas/modules of the system. In addition, Duke has been able to create more simplified, custom reports for Duke as outlined below:

**Accounting View of Payroll Activity (ZH223)**
- Is easily accessed via the transaction code ZH223 as well as customized Duke customized report tree (ZFR1, Duke Favorites).
- Provides **two choices of how to view payroll activity**, either by **cost center funding** (all employees paid from a cost center or range of cost centers) or by **employee funding** (all funding sources for employees belonging to an organizational unit).
- Allows drill down to view details for employees paid, such as pay periods included and any adjustments.
- Replaces legacy report distributed by Payroll.

**Payroll Activity Detail Report – Multi-Period (ZH333)**
- Is easily accessed via the transaction code ZH333.
- Allows selection for a **range of fiscal periods within a single fiscal year** (cannot run across fiscal years) as opposed to just selecting one fiscal period.
- Also allows selection by an **Organizational unit or individual Cost Object**.
- Provides a **cost center funding view** of employee payroll postings funded on cost objects whether those employees belong to the organization or not.
- Lists a summary of each employee for the selected fiscal periods.
- Includes fringe benefit amounts, both standard fringes (GL account 610000) and supplemental fringes (610100) for each employee.
- Does NOT reflect direct postings to salary GL accounts via journal entries (direct postings to salary GL accounts are typically done by Sponsored Programs for retroactive changes or other monitored workload related adjustments). Retroactive entries processed through Payroll will be included in the report.
- Provides the ability to drill-down on an employee to see the amount paid for each fiscal period.
- Also provides the ability to drill down on a fiscal period for Non-Exempt employees and see the amount for each payroll within the fiscal period.
Accounting View of Payroll Activity (ZH223)

Via User Menu: Financials → DUHS Reporting → Organization Reporting → Accounting View of Payroll Activity (Transaction Code ZH223)

On the **Accounting View of Payroll Activity** selection screen:

1. **REQUIRED**: Enter a **Fiscal Period** – (e.g., 02).
2. **REQUIRED**: Enter a **Fiscal Year** – (e.g., 2003).
3. **REQUIRED**: Enter an **Organization unit number** – (e.g., 50012345).
   
   **Note**: Click in the field and click on the **Down arrow** button to find an **Organizational unit number**. Select **Structure Search**. Open the hierarchy by clicking on the **plus (+) folders** next to the appropriate areas. The HR/Payroll hierarchy mirrors the Cost Center hierarchy. On-line users are limited to only those Organizational units to which they should have security access. If no Cost Center selections are entered, then all Cost Objects (Cost Centers or WBS Elements) in the selected organization will be reported.

4. **OPTIONAL**: Enter a **Cost Center** or a range of **Cost Centers**.
   
   **Note**: **Cost centers must belong to selected Organizational unit.**
   
   Click on the **Multiple selection** button to add additional cost centers or ranges.

5. **See Step 5 on the next page.**
5. Select one of the two radio buttons – Cost Center Funding View OR Employee Funding View (per guidelines below).

- **Cost Center Funding View:** to view all employees paid from a cost center or range of cost centers for a fiscal period, **regardless of the organizational unit for the position.** For purposes of this report, WBS Elements are included in the Cost Center selection.

  **OR**

- **Employee Funding View:** to view all funding sources for all employees in your organizational unit(s). This view will show all funding sources for individuals in a particular fiscal period, **regardless of whether the funding source belongs to your organization or not.**

6. To run the report, click on the **Execute** button (F8) (See Screen Captures and Data Descriptions of Two Different Views of Report on Next Pages).
On the **Cost Center Funding (Accounting View of Payroll Activity)** report screen:

```
Cost Center
GL Account Total
Organization to which the employee is assigned. In this example, all of the employees paid from this cost center belong to the same organization as the cost center.
```

```
Cost Center Total
Total for all Cost Objects in the Organization
```

NOTE: See data elements outlined on next page.
7. For the **Cost Center Funding View**: review the list of employees and subtotals for each GL Account within a Cost Center.

**Data elements include:**
- **Cost Object** (Cost Center or WBS Element)
- **GL Account**
- **Employee ID (Duke Unique ID)** - *not displayed below.*
- **Employee Name**
- **Personnel Subarea** (Exempt, Nonexempt, Casual Labor, etc.)
- **Pay Point**
- **Owning Organization** (Organization to which the employee is assigned. The report reflects all employees paid by a Cost Object, whether the employee is assigned to another Organization or not).
- **Dollar Total**
- **Percentage of Employee Pay** for the period.

**Salary G/L Accounts for DUHS:**
*Note:* With the new salary GL accounts for DUHS used with SAP HR/Payroll, users will be able to analyze the dollar amount of salary by different categories of pay within a Cost Center.

The salary GL accounts for DUHS are:

<table>
<thead>
<tr>
<th>Exempt (Monthly)</th>
<th>Nonexempt (Biweekly)</th>
</tr>
</thead>
<tbody>
<tr>
<td>GL Account</td>
<td>Description</td>
</tr>
<tr>
<td>600010</td>
<td>Primary Salary</td>
</tr>
<tr>
<td>600020</td>
<td>Supplemental Pay</td>
</tr>
<tr>
<td>601710</td>
<td>House Staff-Base Pay</td>
</tr>
<tr>
<td>601720</td>
<td>House Staff-Suppl Pay</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
8. For the **Employee Funding View**: review the list of employees with funding sources.

**Data elements include:**
- **Org** - Organizational Unit number, eight digits beginning with 500.
- **Organization Description** – Title of the organization
- **Personnel Subarea** (Exempt, Nonexempt, Casual Labor, etc.)
- **Employee ID** (Duke Unique ID)
- **Employee Name**
- **Cost Center** (Cost Center or WBS Element)
- **Cost Center Description** (Cost Object description)
- **G/L Accounts**
- **Dollar Total** - for the fiscal period. Double click on name for pay period data.
- **Percentage** of Employee Pay for the fiscal period from the Cost Object-GL Account combination. The Total of each employee should equal 100%.
- **Hours for biweekly employees**, on both summary and drilldown screens. Exempt staff or faculty will display N/A.

To export either view of the report to Excel:

9. Follow the menu path: **List → Save → File.**

*Note: Follow Steps per the Export section of the Guide, (where no Export button is available).*
Accounting View of Payroll (cont.)

To drill down on one employee and view the payroll activity (from the Accounting View of Payroll Activity summary screen):

Note: The drill down provides the payroll activity that comprises an employee’s total payroll amount for a fiscal period. This is particularly useful for viewing non-exempt employees since the total for the fiscal month is the sum of two or three payroll periods (based on the month) OR in the case of off-cycle adjustments (e.g. manual checks or retroactive adjustments).

10. Double click on the desired employee or salary amount to be viewed in further detail (see below).

11. View the payroll activity for that employee (see below).

Example: Correction accounting amount - for an off cycle run

Note: The pay period dates and amounts are shown. If the amount is associated with normal payroll posting, the description will be Regular payroll run. For an off-cycle run (manual check, retroactive adjustment, etc.) the description is Correction accounting. The retroactive adjustments are reflected by the Pay Period dates of the retroactive period.
Payroll Activity Detail Report – Multi-Period (ZH333)

Via User Menu: Financials → DUHS Reporting → Organization Reporting → Payroll Activity Detail – Multi-Per (Transaction Code ZH333)

Overview of the Report

This SAP report provides similar detail to the Accounting View of Payroll (ZH223). The report has the additional capability to select the data for multiple fiscal periods to provide detail for fiscal year-to-date payroll activity. Other payroll activity reports allow only one fiscal period to be displayed.

There are several key data points associated with this report:

- Allows the user to select a range of fiscal periods within a single fiscal year. There is no capability to run the report across fiscal years.

- Provides a "Cost Center" view, e.g. all employees funded on my cost objects whether those employees belong to my organization or not. The user can select to run the report for an organizational level or an individual cost object.

- Does NOT provide the "Employee View" option like some other Payroll Activity reports.

- Includes fringe benefit amounts, both standard fringes (GL account 610000) and supplemental fringes (610100) for each employee.

- Does NOT reflect direct postings to salary GL accounts via journal entries (direct postings to salary GL accounts are typically done by Sponsored Programs for retroactive changes or other monitored workload related adjustments). Retroactive entries processed through Payroll will be included in the report.

- Lists a summary of each employee for the selected fiscal periods.

- Provides the ability to drill-down on an employee to see the amount paid for each fiscal period.

- Also provides the ability to drill down on a fiscal period for Non-Exempt employees and see the amount for each payroll within the fiscal period.
Payroll Activity Detail – Multi-Per (cont.)

On the Payroll Activity Detail – Multi-Period screen:

1. **REQUIRED**: Enter one or more Fiscal Periods – (e.g., 010 or a range or a range like 007-009).

2. **REQUIRED**: Enter a Fiscal Year – (e.g., 2017).

3. **OPTIONAL**: Enter an Organization unit number (e.g., 50012345) – all Cost Objects belonging to the selected Organization Unit will be included in the report. Other tips for this field include:
   - If you do not know the Organization unit number, click in the field and use the Drop-down for this field, which displays only the Organization units for which you have security access in SAP.
   - If you do not enter the Organization unit number, a Cost Object or a range of Cost Objects must be selected. **If just the Organization unit number is entered, all Cost Objects** (Cost Centers) in the selected Organization unit will be included.

4. **OPTIONAL**: Enter a single nine digit Cost Object, a range of Cost Objects, OR use the Multiple Selection button to enter additional cost objects (subject to your organizational security access).

5. To run the report, click on the Execute button or press F8.
Payroll Activity Detail – Multi-Per (cont.)

The Payroll Activity Detail – Multi-Period report screen (see example below):

6. Review the columns of data as outlined below that provide a list of employees and subtotals for each G/L Account with the Cost Object, as follows:
   • Cost Object (Cost Center or WBS Element)
   • G/L Accounts and corresponding G/L Account titles in the totals
   • Job Key (Job Code)
   • Personnel Number or Employee ID (Duke Unique ID)
   • Owning Organization (Organization to which the employee is assigned)
   • Personnel Subarea (Exempt, Nonexempt, Temporary, etc.)
   • Employee Name
   • Description of the Job Title
   • GL Account Long Text
   • Amount or Payroll Dollar Total – for the selected fiscal period or periods. Double click on a name for additional pay period or fiscal period data.
   • Fringe amount
   • Supplements

Note: If you run the report on a higher level Organizational Unit, the Organizational Units under that are separated and GL Accounts are totaled.

7. Double click on a line to drill-down
Payroll Activity Detail – Multi-Per (cont.)

7. Double click on a line item to drill down on an individual line item (employee) to see activity detailed by Fiscal period.

8. Review the drill-down results (shown per the step above) to see activity detailed by Fiscal Period if more than one period was selected (see example above).

9. On non-exempt positions, double click on a Fiscal Period line for an employee to drill-down and see activity by Pay Period.

Note: This report may be printed or exported to Excel per the standard steps outlined in any SAP reporting guide (steps for exporting are included in this quick reference as well).
Printing a Report

1. Click on the Print button (menu path: Report → Print).

2. If prompted by the Print Variation reports dialog box, choose to print either the Current report OR All variation reports (in one spool request) as follows:
   - Choose Current report to print the report displayed (best option if only one Cost Object is on the report). This option only prints column headings on the first page of the report.
   - IMPORTANT: Do not choose the option for separate spool request, since this option will print excess pages.
   - Choose All variation reports (in one spool request) to print the consolidated report plus an individual report for each Cost Object. This option prints column headings on every page of every report.

3. Click on the Continue button.

4. If prompted, choose Print all pages or option desired.

5. If prompted by the Print Report dialog box, click on the Print all pages (default) radio button or option desired.

6. Click on the Continue button.
6. **If prompted** by the *Print Current Report* dialog box, click on the *Print formatted report (page length 65)* radio button (the default).

7. Click on the **Continue** button.

---

On the *Print Screen List* dialog box (shown above):

8. **Required**: Ensure the *Output device* field contains an SAP printer value to tell SAP where to print the report.

9. **Required**: Enter *Print out immediately* in the *Time of Print* field (via drop-down), if not defaulted.

10. **Optional**: Enter the *number of copies*.

11. **Optional**: In the *SAP Cover Sheet* field, drop-down and choose *No Cover Sheet* if preferred (if left at System Administrator: Default Setting, then a cover sheet will print).

12. **Optional**: To change other print options and set defaults, click on the *Properties* button (on resulting *Spool Request Attributes* screen, use *Settings* button to set defaults).

13. To complete the print request, click on the **Continue** button.

14. Click the **OK** button to clear the *Information* dialog box if needed.
Exporting a Report to Excel

Note: Once in a report, there are several ways to export a report to Excel depending on the report. Two basic ways are outlined in this section and depend on whether an Export button is available or not.

To export a report to Excel where the Export button is not available:

1. Follow the menu path: System → List → Save → Local File.

OR

To export a report to Excel for reports which have the Export button (example: any line item report):

2. Click the Export button (menu path: List → Export → Local File...)
Exporting a Report to Excel (cont.)

Once one of the two methods on the previous page is used, the rest of the steps are the same, as follows:

In the Save list in file… dialog box:

3. Click on Spreadsheet button.
4. Click on the Continue (Enter) button.

In the dialog box (name varies by report):

5. Click on the Drop-down button in the Directory field.

Note: If the directory path is known, enter the path in the Directory field, enter the file name with an extension of .xlsx in the File Name field, and click on Generate button (skip next steps). If message prompts that file already exists, then click on the Replace button.
Exporting a Report to Excel (cont.)

In the resulting sapfewin (warning message) dialog box:

6. Click OK to continue to the screen shown below.

In the Save As dialog box:

7. Use the Drop Down button in the Save in field to locate a directory path (where to save the file on your computer).

8. Enter the file name with extension of .xls for Excel.

9. Click on the Save button.

IF PROMPTED, in the Save As (warning message) dialog box:

10. If prompted to replace, choose Yes.

10. If prompted to replace the file, click on the Yes button.
Exporting a Report to Excel (cont.)

In the dialog box (*name varies by report*):

11. Ensure the **Directory** and **File Name** fields are correct.
12. Click on either the **Generate** or **Replace** button as appropriate.

In the **Information** dialog box:

13. Review the message stating that bytes were transferred (indicating that the export was successful).
14. Click the **OK** button to close the message.

**Once the file is exported to Excel:**

15. Manually open Excel and retrieve the exported file (or open from desktop if applicable).

   *Note:* **The Profit Center: Plan Actual Comparison Curr./Cumm.** report has a blank page at the top of the Excel file. Scroll down or delete blank rows to view report in Excel and format as needed.

16. **IMPORTANT:** Once changes or formatting have been done, **save the Excel file** per specific instructions below:
   - Use the menu path: **File->Save as**
   - Remove the quotation marks (“xxx”) from the **File name**.
   - Choose **Microsoft Excel Workbook** as the **File type**.

   *Note:* **If the above steps are not done, the changes will not be saved.**

17. Exit Excel when ready (the SAP SAP window is still active and you will return to that window when Excel is closed).